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We’re very lucky here at Macworld. In both print and on the Web, 
we’ve got an amazingly diverse readership. Among our readers there 
are some incredibly geeky, tech-savvy people who can write program-
ming code in their heads and disassemble a MacBook Pro with a  
paper clip. But we’ve also got a lot of readers who consider them-
selves novice Mac users and who avidly read what we write in order 
to flex and improve their Mac skills.

Believe it or not, this book is for both kinds of readers. If you’re one 
of the newer users struggling with the fundamentals of operating a 
Mac, the Mac Basics Superguide will get you up to speed. 

This book is filled with easy-to-follow, detailed tips and informa-
tion about using the Finder and the Dock, switching between programs, using Apple’s Spotlight 
search tool, opening and saving your files, and setting up system preferences and user ac-
counts. We’ve tossed in some basic security and troubleshooting advice to keep your Mac  
up and running smoothly. And our own Dan Frakes, who pens the Mac Gems column in print 
and on the Web, has assembled a list of great low-cost programs that will enhance your  
Mac experience. 	

So that covers the novice users. But what about those geeky Mac experts? Why is this book 
for them?

The answer is simple: It’s for them because it helps everyone they know. It’s for all of their 
friends and family members who use them as the be-all, end-all Mac resource. The reality is, a 
Mac expert can only be in one place at any given time. This Mac Basics Superguide can always 
be around as a handy reference when there’s no flesh-and-blood expert nearby. And with any 
luck, the expert will also be getting fewer calls as his or her friends and family start to master 
their Macs on their own.

Or to put it another way, this is the book I gave to my mom so that she could figure things out 
on her Mac when I’m not available to help.

With this edition of the Mac Basics Superguide, we’ve updated the entire book to reflect the 
changes in Apple’s latest version of Mac OS X, Snow Leopard. And if you find yourself wanting 
more, please consider the other books in our Superguide series, Total Snow Leopard and Mac 
OS X Hints.

I hope you enjoy the book—no matter which kind of Mac user you are.

—Jason Snell, Editorial Director, Macworld
San Francisco, December 2009
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Mac OS X 
at a Glance

6     Wondering where 
your applications are? 
Not sure where to find 
your Home folder? 
This cheat sheet will help you identify OS X’s main 
interface elements.

The Finder
8	 �Parts of the 

Finder
The Finder is the navi-
gation portal into your 
Mac. Discover how 
it works and what its 
different elements do. Get to know the Finder’s vari-
ous view options: cover flow, icon, list, and column. 

13	 Get Oriented
Use the Finder to keep your files and folders orga-
nized, locate applications, and be more efficient with 
your Mac. To get started, become familiar with your 
Mac’s user folder structure.

15	 Easy Finder Tricks
Once you know the basics of the Finder, you can add 
these fun and helpful Finder tricks to your arsenal. 
Get more information about files, preview their con-
tents, and set up shortcuts.

The Dock
18	 �Deploy the 

Dock
Access important 
files and applications 
quickly by storing 
them in the Dock—
the thin reflective shelf filled with icons at the bottom 
of your screen. 

22	 Customize the Dock
Make your Dock work for you by customizing it: pick 
what applications, files, and folders you can access 
from there. You can even change the icon sizes and 
move your Dock around the screen.
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Table of Contents
System 
Preferences
24	 �Working with 

Preferences
One of the best parts 
of a Mac is how cus-
tomizable it is. We’ll 
show you how to access and use preferences and 
adjust them to suit your setup.

27	 Customize Your System
These are some of the more helpful systemwide  
preferences and hints on how to use them.

User 
Accounts
30	 �Types of  

Accounts
Wield the power of 
OS X’s user accounts. 
Learn about the four kinds and see what each is 
capable of.

31	 Creating Accounts
With these instructions it will be a breeze to create 
and modify user accounts on your Mac. 

34	 Work with Multiple Users
Once all of your accounts are set up you can share 
files between users, quickly switch between ac-
counts, and retrieve lost passwords.

36	 Set Parental Controls
If you share your Mac with kids, you’ll want to take 
advantage of OS X’s Parental Controls, which let you 
limit what they access and set time limits for how 
long they can use your computer.

Working 
with Files
40	 �Open and 

Save Files
Preview a file or open 
it with the application 
of your choice. You can also save a file, rename it, 
and get to know its custom menu-bar options.
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44	 Navigate Applications
Snow Leopard has three indispensable tools for 
managing and navigating between open applications: 
Spaces, Exposé, and Application Switcher.

47	 Automate with Services
Don’t do more work than you have to. Automate 
those repetitive and click-intensive tasks with Ser-
vices, a handy feature that has been greatly improved 
in Snow Leopard.

Printing
52	 �The Basics 

of Printing
This section shows 
you how to get your 
printer connected, 
tweak its settings, 
and share it with other computers on your network.

55	 Solving Printer Problems
Even the simplest task, printing a document, can turn 
complicated fast. Find out how to troubleshoot your 
printer with these common fixes.

Get Started 
with OS X 
Apps
58	 �Installing, 

Deleting, and 
Updating 
Programs

While your Mac comes with many of Apple’s great 
programs preinstalled, there’s also a ton of great 
software you can add. Here are the basics on how to 
install, update, and delete programs on your Mac.

61	 Safari
Apple’s built-in Web browser Safari is your portal into 
the Internet. Get the most out of the new Safari 4 by 
learning how to use its many features, including manag-
ing top sites and bookmarks and browsing with tabs.

64	 Mail
With OS X’s e-mail program, you can manage mul-
tiple accounts, banish spam, and check the news 
with the built-in RSS feeder. Snow Leopard even 
offers support for Exchange accounts.

69	 iCal
Keep on schedule with iCal. Create and share events 
and stay organized with To Do lists. iCal is even  
adept at managing multiple calendars.

70	 iChat 
Feeling talkative? iChat lets you share more than 
words with other users—you can also share photos, 
videos, and files. 

72	 Preview
Preview is the fast way to open images and PDFs. 
You can make minor edits, crop, and print from  
Preview, too.

74	 QuickTime Player
With Snow Leopard’s video playback application, 
QuickTime, you can enjoy movies, share videos, and 
record your Mac’s screen.

75	 Image Capture
OS X’s Image Capture is surprisingly powerful. You 
can grab images from your digital camera, scanner, 
or memory cards. 

77	 Smaller Programs
Snow Leopard has many small but useful applica-
tions installed, including Dashboard, Dictionary, Font 
Book, Stickies, and Text Edit.

Searching 
Your Mac
80	 �Using the 

Spotlight 
Menu

The Spotlight menu 
is a one-stop Mac 
searching tool. Find files, applications, e-mails, and 
anything else you think of from your menu bar.

82	 Creating Smart Queries
There are a lot of files on your Mac, and sorting 
through them can take time. Find what you’re looking 
for quickly using phrases and Boolean operators.

86	 �Performing Advanced Searches  
with the Finder

Having trouble finding exactly what you want? For 
complex searches, switch to the Finder window, 
where you can set up multiple criteria.  



4

Mac Basics, Snow Leopard Edition
	 Editor	 Kelly Turner
	 President and CEO	 Mike Kisseberth 
	VP  and Editorial Director	 Jason Snell

	 Managing Editor	 Jennifer Werner 
	A ssociate Editor	H eather Kelly  
	 Copy Editor	P eggy Nauts 
	A rt Director	R ob Schultz 
	 Designers	L ori Flynn,  
		  Carli Morgenstein

Macworld is a publication of Mac Publishing, L.L.C., and International Data Group, 
Inc. Macworld is an independent journal not affiliated with Apple, Inc. Copyright 
© 2009, Mac Publishing, L.L.C. All rights reserved. Macworld, the Macworld logo, 
Macworld Lab, the mouse-ratings logo, MacCentral.com, PriceGrabber, and 
Mac Developer Journal are registered trademarks of International Data Group, 
Inc., and used under license by Mac Publishing, L.L.C. Apple, the Apple logo, 
Mac, and Macintosh are registered trademarks of Apple, Inc. Printed in the United 
States of America.

Have comments or suggestions? E-mail us at ebooks@macworld.com.

Mac 
Security 
Essentials
90	 �Be Safe with 

Passwords 
The most important 
step in keeping your data and computer safe is creat-
ing smart passwords. In OS X, that means using Key-
chain Access. Take advantage of these tips to protect 
your secrets and create unguessable passwords.

93	 Lock Up Your Data 
Encrypting your data is a smart way to keep your files 
hidden from prying eyes and computer thieves.

95	 Make Safe Connections 
Wi-Fi is convenient, but making the wrong kind of 
connection can open up your system to hackers and 
snoops. Here’s how to protect your connections  
using the OS X firewall and common sense.

98	 Protect Your Mac Online
Don’t fall for phishers, hackers, or scammers. Follow 
these rules to make sure your interactions on the 
Internet don’t end in disaster. 

Trouble- 
shooting 
Your Mac
102	 �Back Up with 

Time Machine
Running regular 
backups is the most important part of a Mac mainte-
nance plan. If something goes wrong, you’ll be able 
to get back up and running quickly. Thankfully, OS X’s 
Time Machine program makes backing up all of your 
data easy.  

106	 Recover from Crashes
Backing up your files won’t actually prevent disasters 
from happening. If your applications freeze or your 
computer crashes, try these time-tested remedies 
one at a time to revive your Mac.

113	 Seek Outside Help
When Mac problems are beyond your repair abilities, 
turn to one of these dependable sources for help.

Switching 
from 
Windows
116	 �Transferring 

Your Data
Learn how to bring 
your files over from your PC.

118	 Replacing Windows Software
You don’t have to give up your favorite Windows pro-
grams just because you’re switching to a Mac. 

120	 Bringing Windows with You
If you still need to use Windows from time to time, 
you don’t need a second computer. You can now run 
Windows directly on your Mac.

Worthwhile  
Add-ons
121    These inex-
pensive programs 
can pick up where OS 
X leaves off, helping 
you be more produc-
tive, keep an eye on your system, and save time.
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User Accounts
Protect Personal Files and Settings on a Shared Mac

ac OS X lets you create separate identities—known 
as user accounts—on your Mac. User accounts are 
great for a group of people who want to work on the 

same computer but who have unique needs. Each user controls 
his or her own settings, desktop space, and system preferences. 
And each user controls access to his or her files. 

If you’re the only person working on your Mac, you may have 
just one user account. But you can create as many accounts 
as you need for friends, family members, colleagues, or even 
guests. And other users can’t view or open your files, so your 
user account gives you privacy.

Table of contents

30	 Types of Accounts
31	 Creating Accounts
34	 Work with Multiple Users
36	 Set Parental Controls

M
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to any accounts you want to control). When setting 
up a new account, select Managed With Parental 
Controls from the Account pull-down menu. To add 
parental controls to an existing account, click the ac-
count name and turn on the Enable Parental Controls 
option. You can apply parental controls to any non- 
administrator account, including the guest account.

You Can’t Do That  Parental controls let you establish which Web sites your children can visit (left). Select the  
Customize button to give the OK to certain sites (right).

Set Parental Controls
ids can have a lot of fun exploring a Mac, 
but there can be pitfalls as well. To begin 
with, that child could become overwhelmed 

by the Mac’s interface. He or she, if given too broad 
powers, could also delete important files and applica-
tions. And finally, if allowed to do so, that child could 
come face-to-face with some of the less seemly 
sides of the Internet. Snow Leopard helps protect 
both your child and your computer’s data by allowing 
you to create accounts with specific limitations. 

The key to creating these accounts is the Paren-
tal Controls setting. For example, you can control 
access to certain system settings and programs, 
manually select the people with whom your kids can 
exchange e-mail and chat messages, set time limita-
tions for computer use, and identify which Web sites 
users can visit. These types of limitations are useful 
not just to parents, but also teachers, IT departments, 
and businesses that offer public computer stations.

Getting Started
To turn on parental controls, you’ll need to have a 
non-administrator account already set up in the  
Accounts preferences pane (you can’t restrict admin 
accounts, so make sure you don’t give admin powers 

K Control Access  
from Afar
Don’t want to make a trip to your son’s room each 
time he needs access to a blocked Web site or 
wants to add a friend to his iChat list? When setting 
up his parental controls, click the gear icon at the 
bottom of the user list and select Allow Remote 
Setup. You’ll now be able to manage these controls 
from another computer. With this option enabled on 
a Mac, that Mac’s non-admin accounts will appear 
in the Parental Controls user list on other Macs 
on your home network, allowing you to configure 
those accounts’ Parental Controls settings over 
the network—a convenient option in a lab or home 
setting.
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or expressly allow access to certain sites, click the 
Customize button. This list of allowed sites overrides 
Snow Leopard’s standard content filter for these 
sites, but uses the filter for all other sites.

To restrict Web access to only those sites that you 
explicitly approve of, select the Allow Access To Only 
These Websites option. Then click the plus-sign but-
ton and enter the URLs (and names) of sites you want 
to allow. 

Manage Mail & iChat 
If you’re worried about your kids receiving sleazy 
spam or exchanging e-mail messages with strangers, 
you can set up white lists of trusted e-mail corre-
spondents. You can add e-mail and IM addresses by 
clicking the plus-sign button. If you select the Send 
Permission Emails To option, Apple’s Mail app will 
send a message to you so you can authorize e-mail 
messages to or from people not on the white list. 
That’s handy if your child is working on a school proj-
ect and needs to send and receive messages from 
new people, for instance.

Set Time Limits 
Want to make sure your daughter isn’t chatting with 
friends when she should be studying or sleeping? 
The Time Limits screen lets you restrict when and 
for how long each user has access to the Mac (see 
“Limiting Computer Use”). 

Once you’ve turned on parental controls for an 
account, open the Parental Controls preference pane, 
and select the account name from the column on the 
left. The Parental Controls settings for a particular ac-
count are divided into five screens: System, Content, 
Mail & iChat, Time Limits, and Logs.

Control the System 
The System screen lets you control the appearance 
of the Finder, select which programs are accessible, 
prohibit burning CDs or DVDs, and prevent changes 
to printer, Dock, and password settings.

If you’re setting up your Mac for young children, 
the Use Simple Finder option is a good starting point. 
It presents a very limited interface to the user: the 
Dock contains three folders (Applications, Docu-
ments, and Shared), and the user can work only with 
the applications you choose. To set up this list, click 
the Applications disclosure triangles for the group 
of applications you want to manage—iLife, iWork, or 
Internet, for example—to reveal a list of available ap-
plications. Select the applications you want the user 
to have access to (and deselect those you don’t if 
they’re selected).

On the other hand, if you want to restrict what 
program the user can open but don’t want to use the 
simplified interface, select the Only Allow Selected 
Applications option. By default, this option bars the 
user from all areas of the Mac except applications; 
you choose whether to allow additional options. 
For instance, you can let the user modify the Dock, 
administer printers, and burn CDs and DVDs. As with 
the Simple Finder, you can allow any or all applica-
tions; click the disclosure triangles to see the pro-
grams available on your Mac. 

Limit Content 
The Content screen includes controls for Safari and 
Dictionary to limit what type of content your kids 
come into contact with (see “You Can’t Do That”). 

The Hide Profanity In Dictionary option simply pre-
vents this user from viewing certain words. You have 
no control over which words Dictionary blocks.

Safari’s parental controls give you basic control 
over what your kids can access when surfing. OS X 
includes a content filter that intercepts Web pages on 
the fly and determines if each is “suitable for kids.” If 
you select the Try To Limit Access to Adult Websites 
Automatically option, Safari will restrict access to any 
pages it deems unsuitable. To restrict additional sites 

Limiting Computer Use  Snow Leopard lets you en-
force bedtimes and restrictions on computer usage by 
setting up time limits.

37

User Accounts



same day—for example, to exclude computer time 
from 8 p.m. to 7 a.m. and from 9 a.m. to 4 p.m.)

Keep Track with Logs 
Just setting up a restricted account may not be 
enough to give you peace of mind. To remain vigilant 
about who your kids are interacting with and what 
sites they’re visiting, you can use the Logs screen. 
From here you can monitor the activity of a controlled 
account, including a list of all visited Web sites, any 
blocked sites that the user attempted to access, pro-
grams used, and anyone with whom the user chat-
ted using iChat. A pop-up menu lets you restrict the 
log view to the current day or the past week, month, 
three months, six months, or year. You can also group 
the log display by date or by Web site.

Keep in mind that any user on your Mac who has 
administrator status can change settings and view 
logs in the Parental Controls pane. Although this is 
not likely to be an issue in a home setting, where it 
might be desirable for two or more adults to be able 
to keep an eye on controlled accounts, it could be  
a drawback in other situations—for example, if  
you’re using parental controls in an office or educa-
tional setting. This is another reason you should give 
administrator status to accounts only when abso-
lutely necessary.

You can set separate time limits for weekdays 
and weekend days, and you can also restrict usage 
during certain hours. For example, you can restrict an 
account to two hours per day of use during the week 
and three hours on weekend days, and block access 
completely from 8 p.m. to 7 a.m. on school nights 
and from 10 p.m. to 8 a.m. on weekends. (Unfortu-
nately, you can’t set up multiple ranges during the 

Transfer Settings
Setting up parental controls for multiple accounts? 
If the accounts are going to have the same set-
tings, first configure one of the accounts. Then 
click the gear icon at the bottom of the accounts 
list and choose Copy Settings For Username from 
the pop-up menu that appears. Finally, select an-
other account and then choose Paste Settings To 
Username. This applies the first account’s Parental 
Controls settings to the second account, saving you 
the trouble of having to configure each separately. 
Even if you don’t plan on configuring each exactly 
the same way, you can still use this technique and 
then go back and make the necessary changes to 
each account; assuming you’re at least configuring 
the accounts somewhat similarly, this will still save 
you a lot of work.
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Get Started with OS X Apps
How to Get Up and Running with Safari, Mail, iChat, and More

new Mac comes with more than 40 applications 
installed: standards such as programs for checking 
your e-mail, surfing the Web, and managing contacts; 

creative tools for editing photos, listening to music, and designing 
Web sites; smaller aids for looking up definitions, writing notes, 
and checking the weather; and more. You can also install addi-
tional applications from Apple and third-party developers such as 
Adobe and Microsoft to add features that don’t come built-in.

Although taking you step by step through everything Snow 
Leopard’s built-in programs can do would take up an entire book 
on its own, here are the basics you need to know to get started 
with the most essential apps—as well as information on installing 
or deleting additional software.

Table of contents

58	 �Installing, Deleting, and  
Updating Programs

61	 Safari
64	 Mail
69	 iCal
70	 iChat 
72	 Preview
74	 QuickTime Player
75	 Image Capture
77	 Smaller Programs

A
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Get Started with OS X Apps

Edit Events
If you want to edit an event already on the 
calendar, double-click its title to open an 
editable Info pane. (If the pane that pops up 
doesn’t let you edit its contents, open iCal’s 
Advanced preferences and turn on the 
Open Events In Separate Windows option.)

Manage Multiple Calendars
Unlike paper calendars, iCal lets you create multiple 
calendars—for instance, a work calendar, a home 
calendar, a calendar that lists the year’s holidays 
and birthdays, and yet another calendar for your pet 
chinchilla. 

To create a new calendar, click the plus sign in the 
bottom left corner of the window. A new entry will ap-
pear under the Calendars heading (if you don’t see it, 
choose View ▶ Calendar List).  

You can assign any color you want to a calendar—
to help you distinguish its events from another calen-
dar—by selecting the calendar’s name and pressing 
1-I. Click the colored pull-down menu and choose 

a new color from the list, or choose 
Other to designate your own color. 

Now, when you create 
a new event, you can 
assign it to a specific 
calendar by opening 
the Calendar pull-down 
menu in the edit pane. 

Stay Organized
iCal also offers a To Do 
list (which integrates 
with Mail) where you can 
check off items as you 
complete them. To dis-
play this pane, choose 
View ▶ Show To Do List.

If you want to share your schedule 
with the rest of the world, feel free to 
publish your calendar to your Mo-
bileMe account ($99 per year; apple 
.com/mobileme) or to a private server.

iCal
pple’s calendar application, iCal, 
helps you manage your sched-
ule. Just like a paper calendar on 

the kitchen wall, iCal provides space for 
jotting down one-time events or recurring 
ones. You can view those events in Day, 
Week, or Month views.

Create a New Event
To add an event to iCal, press 1-N or double-click 
the desired day (see “Make a Date”). In the resulting 
window, enter an event name, set the time—or turn 
on the All Day option for events that don’t have a 
specific time—and add any additional details you’d 
like. If you’re worried about forgetting your meeting, 
you can set a text or audio alarm to go off before the 
event (you can choose how much warning the alarm 
gives you, ranging from days to minutes beforehand). 
You can even attach files to the event, so you don’t 
forget your agenda, for example. Click Done to close 
the window and add your new event to the calendar. 

A

Make a Date   iCal helps you keep track of your schedule. You can 
switch between Day, Week (shown here), and Month views A. Enter the 
details of your appointments in iCal’s Info pane B. You can also keep 
track of to-do items.

A

b

http://www.apple.com/mobileme
http://www.apple.com/mobileme
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Switching from Windows 
How to Make the Leap without Losing Your Files…or Your  Sanity

emember the last time you moved? For all the promise 
of major long-term gain, there was at least some short-
term pain: boxes to pack and unpack, new neighbors 

to meet, and a house to turn into a home.  
Moving from a Windows PC to a Mac presents the same 

kinds of opportunities and challenges. It requires some up-front 
effort: transferring your old data to your new machine, getting 
your essential hardware and software up and running, and learn-
ing your way around.

Here’s a quick guide to the most important steps.

Table of contents

116	 Transferring Your Data
118	 Replacing Windows Software
120	 Bringing Windows with You

R
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Switching from Windows 

Transferring Your Data
ust because you’re leaving your Windows 
PC doesn’t mean you have to leave your 
files behind, too. These days, most com-

mon file types—including photos, word-processing 
files, spreadsheets, and e-mail—will work just fine on 
the Mac. And for those that don’t, inexpensive utili-
ties can often translate them to a compatible format. 
However, if you’ve had that old PC for a while, you 
could have many gigabytes of stuff to move. 

So how do you safely move that mass of data from 
one machine to the other? You actually have a couple 
of options. 

Use an External Hard Drive 
Apple’s support site (macworld.com/5452) suggests 
several different methods for transferring files from a 
PC to a Mac. One of the easiest is to use an external 
USB hard drive. 

If you don’t already have an external drive, there’s 
no better time to buy one: they’re cheap, and you’ll 
probably want one for use with OS X’s Time Machine 
backup utility (see the Troubleshooting Your Mac 
chapter). 

For data-transfer purposes, make sure the drive is 
formatted using Windows’ FAT32 file system, so both 
your Windows PC and your Mac can read it and write 
to it. After you’re done copying files over, use OS X’s 

Moving Day  An 
external hard drive 
such as this LaCie 
d2 Quadra offers an 
easy way to move 
files and later serve 
as your backup drive.

Disk Utility (Applications ▶ Utilities) to reformat the 
drive as Apple’s HFS+ so you can use it with Time 
Machine.

To transfer files via your USB drive, connect the 
hard drive to the PC, drag your data onto it, and then 
disconnect it. Now attach it to your Mac, and drag 
the data onto the Mac’s hard drive using the Finder, 
OS X’s equivalent of Windows’ Explorer (for more in-
formation, see The Finder chapter). Your Home folder, 
which appears in the left-hand pane of the Finder 
and is equivalent to My Documents, is a good place 
to copy your personal files; it’s got folders for Docu-
ments, Movies, Music, and Pictures.

Over the Network
You can also shuttle files from your old PC to your 
new Mac using a wireless or wired network; how-
ever, the process can be a hassle depending on your 
setup. Here’s one way to do it: 

On your Windows PC, select Run from the Start 
menu, type cmd, and then click OK. In the subse-
quent command line, type ipconfig. 

Make a note of the IP address that appears. 
Next, use Windows’ Explorer to navigate to a folder 
containing files you’d like to transfer to the Mac. 
Right-click on it, choose Properties, and click the 
Sharing tab. Select Share The Folder On The Network 
(Windows may demand confirmation that you know 
what you’re doing), and then choose a Share name. 
Click OK.

J TIP  
Convert Your 
Media
Many Windows media formats 
will transfer and play back seamlessly 
on a Mac. One big exception is music and video in 
Microsoft’s Windows Media formats. For these files, 
we recommend getting Telestream’s Flip4Mac WMV 
Player (macworld.com/5453), which lets you play 
them in QuickTime. The basic player is free; there’s 
also a $29 Flip4Mac WMVPlayer Pro that can export 
your files to a Mac-compatible format. 

http://www.macworld.com/5452
http://www.macworld.com/5453
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boxes), so, if your old e-mail client can export in that 
format, you should be able to make the transfer.

Let Someone Else Do It
If you’re willing to invest $40 in simplifying the 
moving-to-the-Mac process, consider Detto Tech-
nologies’ Move2Mac (detto.com). This Windows-
to-Mac migration utility not only transfers your files 
via network or external drive (shuttling items from 
Windows’ My Documents to OS X’s equivalent fold-
ers) but also moves your Outlook e-mail and address 
book, browser favorites, and even your wallpaper 
preferences. 

On your Mac, go to the Finder and select Connect 
To Server in the Go menu. In the text field that ap-
pears, type a server address in this format:  SMB://
ipaddress/sharename. (For example, if the IP 
address is 10.0.1.8 and the share name you chose is 
windowsstuff, you’d type SMB://10.0.1.8/ 
windowsstuff.) When you click OK, your shared 
folder in Windows should show up in the Finder, let-
ting you drag its contents onto the Mac. 

Moving E-mail
Getting your old e-mail from your PC onto your Mac 
is easy if you’ve been using a POP3 or IMAP account 
that leaves messages on the server. Just launch 
Mail on your Mac (it’s the postage-stamp icon in the 
Dock), choose Mailbox ▶ New Mailbox, and follow 
the instructions to add your account and download 
mail (see “Mail” in the Get Started with OS X Apps 
chapter for more on OS X’s e-mail program).

If your e-mail account doesn’t store your mes-
sages on a server, but stores them on your computer 
instead, transferring them to a new machine can 
be tough. Where and how those e-mails are stored 
depends largely on which e-mail client you use. Our 
best advice is to perform a Google search using the 
name of your old e-mail client and the phrase  
"transfer e-mail". OS X’s Mail app can import 
mail in mbox format (choose File ▶ Import Mail-

Where Is Everything?
Most major Windows features have counterparts in Snow Leopard.

If you used this in Windows Look here in OS X For more information see

Start menu Apple menu and Applications folder Working with Files chapter 

Taskbar Dock The Dock chapter 

System tray Right side of menu bar Mac OS X at a Glance chapter  

Explorer Finder The Finder chapter  

Preview pane Quick Look The Finder chapter 

Flip 3D (Vista and Windows 7) Exposé Working with Files chapter 

Control Panel System Preferences System Preferences chapter  

My Documents Home folder The Finder chapter  

Search Spotlight Searching Your Mac chapter 

Gadgets and Sidebar (Vista and  
Windows 7)

Dashboard Get Started with OS X Apps chapter  

Backup (XP) and Backup and  
Restore Center (Vista and Windows 7)

Time Machine Troubleshooting Your Mac chapter 

Recycle Bin Trash The Dock chapter  

Move It for Me  Move2Mac transfers files, folders, and 
more from your Windows PC to your Mac.

http://www.detto.com


Nobody spends more time with Apple’s computers 
and software than the writers and editors at Macworld, 
the world’s foremost Mac authority. 

Now Macworld’s team of experts has used its knowl-
edge to create this straightforward guide to getting 
started with your Mac running OS X 10.6 (Snow  
Leopard). Whether you’re new to the Mac, just need 
a refresher course, or suspect that you’ve only 
scratched the surface of your Mac’s potential, the 
Macworld Mac Basics Superguide, Snow Leopard Edition 
will give you the step-by-step advice you need to 
become a Mac whiz. 

Inside these pages, you’ll find detailed tips and infor-
mation about navigating your system using the Finder 
and the Dock and managing and switching between 
programs using Exposé and Spaces. You’ll learn how 
to find anything using the Spotlight search tool and 
the best ways to open, save, organize, and print files. 
We include tips on customizing your Mac to suit your 
needs through system preferences, including how to 
add and control user accounts. Our experts also give 
you vital troubleshooting and security advice—and 
even recommend 20 inexpensive add-on programs 
that can improve your Mac experience in ways you’ve 
never thought possible. To help you take advantage of 
Apple’s built-in applications, we’ve also included help-
ful pointers on getting started with Safari, Mail, iChat, 
and other included Apple software. 

Let Macworld’s team of experts show you how to get 
the most out of your Mac.
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